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Copyright and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The
information contained herein is designed only for use with this Epson printer. Epson is not responsible for any use of this information
as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses,
costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of this product or unauthorized
modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's

operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable
products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use
of any interface cables other than those designated as Epson Approved Products by Seiko Epson Corporation.

EPSON® is a registered trademark and Exceed Your Vision is a trademark of Seiko Epson Corporation.
Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

DPOF™ is a trademark of CANON INC., Eastman Kodak Company, Fuji Photo Film Co., Ltd. and Matsushita Electric Industrial Co.,
Ltd.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson
disclaims any and all rights in those marks.

Copyright © 2008 Seiko Epson Corporation. All rights reserved.
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Operating System Versions

In this manual, the following abbreviations are used.

Windows refers to Windows Vista, XP, XP x64 and 2000.

ad  Windows Vista refers to Windows Vista Home Basic Edition, Windows Vista Home Premium Edition, Windows
Vista Business Edition, Windows Vista Enterprise Edition, and Windows Vista Ultimate Edition.

a  Windows XP refers to Windows XP Home Edifion, Windows XP Professional x64 Edition, and Windows XP
Professional.

a  Windows 2000 refers to Windows 2000 Professional.

Operating System Versions 9
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Safety Instructions

Important Safety Instructions

Read all of the instructions in this section before using the printer. Also, be sure to follow all
warnings and instructions marked on the printer.

Setting up the printer

Observe the following when setting up the printer:

a

a

Do not block or cover the vents and openings in the printer.
Use only the type of power source indicated on the printer’s label.

Use only the power cord that comes with the printer. Use of another cord may result in fire or
electric shock.

The printer’s power cord is for use with the printer only. Use with other equipment may result
in fire or electric shock.

Be sure your AC power cord meets the relevant local safety standard.

Avoid using outlets on the same circuit as photocopiers or air control systems that regularly
switch on and off.

Avoid electrical outlets controlled by wall switches or automatic timers.

Keep the entire computer system away from potential sources of electromagnetic interference,
such as loudspeakers or the base units of cordless telephones.

Do not use a damaged or frayed power cord.

If you use an extension cord with the printer, make sure that the total ampere rating of the
devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make
sure that the total ampere rating of all devices plugged into the wall outlet does not exceed the
wall outlet’s ampere rating.

Do not attempt to service the printer yourself.

Safety Instructions
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1 Unplug the printer and refer servicing to qualified service personnel under the following
conditions:
The power cord or plug is damaged; liquid has entered the printer; the printer has been
dropped or the casing damaged; the printer does not operate normally or exhibits a distinct
change in performance.

[ If you plan to use the printer in Germany, the building installation must be protected by a 10 or
16 amp circuit breaker to provide adequate short-circuit protection and over-current protection
for the printer.

1 When connecting the printer to a computer or other device with a cable, ensure the correct
orientation of the connectors. Each connector has only one correct orientation. Inserting a
connector in the wrong orientation may damage both devices connected by the cable.

1 If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are
fuses in the plug, make sure you replace them with fuses of the correct size and rating.

1 Do not hold the duplex unit when you lift the printer to prevent the duplex unit from becoming
detached. Also, make sure that the duplex unit is attached correctly after setting up the printer.

Choosing a place for the printer

Observe the following when choosing a place for the printer:

[ Place the printer on a flat, stable surface that extends beyond the base of the printer in all
directions. If you place the printer by the wall, leave more than 10 cm between the back of the
printer and the wall. The printer will not operate properly if it is tilted at an angle.

(d  When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside
down. Otherwise, ink may leak from the ink packs.

Leave enough space in front of the printer for the paper to be fully ejected.

Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer
away from direct sunlight, strong light, or heat sources.

Avoid places subject to dust, shocks, or vibrations.
Leave enough room around the printer to allow for sufficient ventilation.

Place the printer near a wall outlet where the plug can be easily unplugged.

Using the printer

Observe the following when using the printer:

Safety Instructions 11
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U J o oJ oo

Avoid touching the components inside the printer unless instructed to do so in this guide.
Do not insert objects through the slots in the printer.

Take care not to spill liquid on the printer.

Do not touch the white flat cable inside the printer.

Do not put your hand inside the printer during printing.

Do not use aerosol products that contain flammable gases inside or around this product. Doing
so may cause fire.

Do not move the print head by hand; otherwise, you may damage the printer.

Always turn off the printer using the O Power button. When this button is pressed, the
O Power light flashes. Do not unplug the printer or turn off the power to the outlet until the
O Power light stops flashing.

Before transporting the printer, make sure that the print head is in the home (far right) position.

Be careful not to trap your fingers when closing the printer cover.

Handling ink cartridges

Observe the following when handling ink cartridges:

a
a

Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

Shake the ink cartridge well before installing it for best results.

0:00'05"
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Caution:
Do not shake cartridges (that have been installed previously) with too much force.

Do not use an ink cartridge beyond the date printed on the cartridge carton.
Use up the ink cartridge within six months of installation for best results.
Do not dismantle the ink cartridges. This could damage the print head.

Store ink cartridges in a cool, dark place.

U J o oJ o

After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room
temperature for at least three hours before using it.

(.

Do not touch the green IC chip on the side of the cartridge. This may affect normal operation
and printing.The IC chip on this ink cartridge retains a variety of cartridge related-information,
such as the ink cartridge status, so that the cartridge may be removed and reinserted freely.
However, each time the cartridge is inserted, some ink is consumed because the printer
automatically performs a reliability check. If you remove an ink cartridge for later use, protect
the ink supply area from dirt and dust, and store it in the same environment as this product.
Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care
is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink
supply port or surrounding area.

Warnings, Cautions, and Noftes

Warnings, Cautions, and Notes in this User's Guide are indicated as below and have the following
meaning.

Warnings

must be followed carefully to avoid bodily injury.

n Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of the printer.

Safety Instructions 13
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Chapter 1
Using Your Software

Overview of Printer Driver and Status Monitor

The printer driver lets you choose from a wide variety of settings to get the best printing results.
Status Monitor and the printer utilities help you check the printer and keep it in top operating
condition.

Accessing the printer driver for Windows

You can access the printer driver from most Windows applications, the Windows Start menu, or
the taskbar.

To make settings that apply only to the application you are using, access the printer driver from
that application.

To make settings that apply to all of your Windows applications, access the printer driver from the
Start menu or the taskbar.

Refer to the following sections to access the printer driver.

Note:
Screen shots of the printer driver windows in this User’s Guide are from Windows XP.

From Windows applications
1. Click Print or Print Setup on the File menu.

2. Inthe window that appears, click Printer, Setup, Options, Preferences, or Properties.
(Depending on your application, you may need to click one or a combination of these buttons.)

Using Your Soffware 14
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From the Start menu

1. Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and
Sound category. (If the Control Panel is in Classic View, click Printers.)

Windows XP:
Click Start, Control Panel, then click Printers and Faxes. (If the Control Panel is in Category
View, click Printers and Other Hardware, then click Printers and Faxes.)

Windows 2000:
Click Start, point to Settings, then click Printers.

2. Windows Vista:
Select the printer and then click Select printing preferences.

Windows XP and 2000:
Select the printer, then click Printing Preferences on the File menu.
From the shortcut icon on the taskbar

Right-click the printer icon on the taskbar, then select Printer Settings.

To add a short cut icon to the Windows taskbar, first access the printer driver from the Start menu
as described above. Next, click the Maintenance tab, the Speed & Progress button, and then the
Monitoring Preferences button. In the Monitoring Preferences window, select the Select
Shortcut Icon check box.

Getting information through online help

You can access online help for items in the printer driver from your application or the Windows
Start menu.
= See “Accessing the printer driver for Windows” on page 14.

In the printer driver window, try one of the following procedures.

1 Right-click the item, then click Help.

0 Click the ﬂ button at the top right of the window, then click the item (for Windows XP and

2000 only).

Using Your Soffware 15
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Printing Web Pages to Fit fo Your Paper Size

=

EPSON Web-To-Page
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EPSON Web-To-Page lets you make Web pages fit to your paper size when printing. You can also
see a preview before printing.

Note:

This software is not available for Windows Vista and XP x64.

Note for Windows Internet Explorer 7 users:
Printing web pages to fit to your paper size is a standard feature in Windows Internet Explorer 7.

Using Your Software 16
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Accessing EPSON Web-To-Page

After you install EPSON Web-To-Page, the menu bar is displayed on the Windows Internet

Explorer Toolbar. If it does not appear, select Toolbars from the View menu of Internet Explorer,
and then select EPSON Web-To-Page.

2 Epson Global Home - Microsoft Internet Explorer

File Edit \iew Fawvarites Tools  Help

] =y 0
@Back - __,«’; |£| IELI _;; 7 Search ‘E/\?Favnrites

Address @ hkkp: f funana, epsan, comf
EPSOMN Web-To-Page - (Z3Print | =] Print Preview

Uninstalling the Printer Software

Uninstalling the printer driver

You may need to uninstall your printer driver if you:

1 Upgrade your computer’s operating system.
1 Update your printer driver with a newer version.
d Have a problem with the printer driver.

If you are upgrading your operating system or updating the printer driver version, be sure to
uninstall the current printer driver before upgrading or installing the new driver. Otherwise, the
driver update will not work.

For Windows

Note:
[ To uninstall programs in Windows Vista, you need an administrator account and the password if you
log on as a standard user.

To uninstall programs in Windows XP, you must log on to a Computer Administrator account.

To uninstall programs in Windows 2000, you must log on as a user with administrative privileges
(belonging to the Administrators group).

Using Your Software 17
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Turn off the printer and disconnect its interface cable.

Windows Vista:
Click the start button and select Control Panel.

Windows XP:
Click Start and select Control Panel.

Windows 2000:
Click Start, point to Settings, and select Control Panel.

Windows Vista:

Click Uninstall a program from the Programs category, and then select EPSON Printer
Software from the list.

Windows XP and 2000:

Double-click the Add/Remove Programs icon and select EPSON Printer Software from the
list.

Windows Vista:
Click Uninstall/Change.

Windows XP and 2000:
Click Change/Remove.

Select the icon for your printer and click OK.

Click OK to uninstall the printer driver.

Using Your Software 18



B-300/B-500DN  User’s Guide

Uninstalling the User’s Guide

For Windows

Note:

a

To uninstall programs in Windows Vista, you need an administrator account and the password if you
log on as a standard user.

To uninstall programs in Windows XP, you must log on to a Computer Administrator account.

To uninstall programs in Windows 2000, you must log on as a user with administrative privileges
(belonging to the Administrators group).

Turn off the printer and disconnect its interface cable.

Windows Vista:
Click the start button and select Control Panel.

Windows XP:
Click Start, then select Control Panel.

Windows 2000:
Click Start, point to Settings, and select Control Panel.

Windows Vista:
Click Uninstall a program from the Programs category.

Windows XP and 2000:
Double-click the Add or Remove Programs icon.

Select this printer's Manual from the list.

Windows Vista:
Click Uninstall/Change.

Windows XP and 2000:
Click Change/Remove.

Click OK.

Using Your Soffware
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Chapter 2
Paper Handling

Using Special Paper

You can achieve good results with most types of plain bond paper. However, coated papers
provide superior printouts because they absorb less ink.

Epson provides special papers that are formulated for the ink used in Epson ink jet printers, and
recommends these papers to ensure high-quality results.

= See “Paper, Consumables, and Option” on page 156.

When loading special paper distributed by Epson, read the instruction sheets packed with the
paper first and keep the following points in mind.

Note:

A Load the paper into the rear sheet feeder printable side up. The printable side is usually whiter or glossier.
See the instruction sheets packed with the paper for more information. Some types of paper have cut
corners to help identify the correct loading direction.

Q  If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on
curled paper may cause ink to smear on your printout.

Note for Professional Flyer Paper:
[ If water gets on the printable side, wipe off the water. Be careful not to scuff or scratch the printable side.

Do not touch the printable side. Moisture and oils from your skin can affect print quality.

1 Professional Flyer Paper supports double-sided printing. When you use the double-sided printing
function, feed the paper manually.

1 When you use the double-sided printing function, let the printed side dry for about 20 minutes before
printing the back side.

Paper Handling 20
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d When you use the double-sided printing function, printing the low print duty side first is recommended.

Depending on the print pattern, marks made by the rollers may appear on the printed side. Print one test
copy and examine the results before printing many sheets.

1 Depending on the printing environment, the output paper cannot be stacked. In this case, use the output
support tray.

Output support tray stacks 50 sheets of one-sided printing and 25 sheets of double-sided printing.

= See “Setting output support tray for Epson Professional Flyer Paper” on page 28.

Loading capacities for Epson special media
Refer to the table below for the loading capacities of Epson special paper and other media.

Front paper cassette:

Media Type Loading Capacity

Epson Bright White Ink Jet Paper Up to 400 sheets

Rear sheet feeder:

Media Type Loading Capacity
Single-sided Printing Manual Double-sided Printing
Epson Bright White Ink Jet Paper Up to 100 sheets Up to 70 sheets
Epson Professional Flyer Paper Up to 70 sheets Up to 50 sheets
Epson Photo Paper Up to 60 sheets -
Epson Matte Paper-Heavyweight Up o 20 sheets -
Epson Double-Sided Matte Paper Up to 1 sheet Up to 1 sheet
Epson Photo Quality Ink Jet Paper Up to 100 sheets -
Envelopes Up to 15 sheets -
Note:

If the paper is curled, flatten it or curl it slightly in the opposite direction. Make sure the paper stack fits
under the = arrow mark inside the edge guide.

Paper Handling 21



B-300/B-500DN  User’s Guide

Storing Epson photo paper

Return unused paper to the original package as soon as you finish printing. Epson recommends
storing your printouts in a resealable plastic bag. Keep them away from high temperature,
humidity, and direct sunlight.

Loading Paper

Follow these steps to load paper:

Into the front paper cassette

1. Pull out the front paper cassette.

Paper Handling 22
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2. Slide the edge guides while pinching their knob to accommodate the paper you are loading.

3. Fan a stack of paper, then tap it on a flat surface to even the edges.

4. Load the paper with the printable side down.

Note:
Avoid adding paper before running out of paper. Doing so may prevent the paper from feeding smoothly.

Paper Handling 23
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5. Slide the edge guides while pinching their knob to fit the paper you are loading.

6. Reinsert the cassette into the printer.

Note:
Do not insert the front paper cassette with force. Doing so may cause the paper to jam.

Do not move the edge guides after reinserting the front paper cassette. Doing so may cause the paper
to jam.

7. Slide out and extend the extension tray.

Paper Handling 24
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Note:
[ Leave enough space in front of the printer for the paper to be fully ejected.

d  Make sure the paper stack fits under the = arrow mark inside the left edge guide.

Into the rear sheet feeder

1. Open the paper support.

Paper Handling 25
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4. Fan a stack of paper, then tap it on a flat surface to even the edges.

5. Load the paper with the printable side up, against the right side of the rear sheet feeder. Then
slide the left edge guide against the left edge of the paper.

Note:
[ Leave enough space in front of the printer for the paper to be fully ejected.

Always load paper into the rear sheet feeder short edge first, even when you are printing
landscape-oriented pictures.

1 Avoid adding paper before running out of paper. Doing so may prevent the paper from feeding smoothly.

d  Make sure the paper stack fits under the = arrow mark inside the left edge guide.

Loading Envelopes

Follow these steps to load envelopes:

1. Open the paper support.

Paper Handling 26



B-300/B-500DN  User’s Guide

2. Slide out and extend the extension tray.

4. Load envelopes short edge first with the flap facing down and to the left. Then slide the left
edge guide against the left edge of the envelopes.

Paper Handling 27
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Note:

a

I I W

a

The thickness of envelopes and their ability to fold vary widely. If the total thickness of the stack of
envelopes exceeds 15 mm, press down on the envelopes to flatten them before loading. If print quality
declines when a stack of envelopes is loaded, load one envelope at a time.

You can load up to 15 envelopes at a time in the rear sheet feeder.
Do not use envelopes that are curled or folded.

Flatten the envelope flaps before loading.

Flatten the leading edge of the envelope before loading.

Awvoid using envelopes that are too thin, as they may curl during printing.

For printing instructions, see the following instructions.
= See “Printing on Envelopes” on page 38.

Seftting Output Tray

The output tray is located on the front paper cassette. Slide out the extension tray and then open
the flap on the extension tray to prevent your prints from slipping off the printer.

Setting output support tray for Epson Professional Flyer Paper

When you print on the Epson Professional Flyer Paper, set the output support tray. The use of the
output support tray is recommended especially when the output paper is curled and cannot be
stacked. Follow these steps to set the output support tray.
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1. Pull out the output tray.

2. Slide the output support tray until it clicks. The output support tray is lifted slightly.

3. Reinsert the output tray into the printer.
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Note:
After printing on the Epson Professional Flyer Paper, push the output support tray to move it to its original
position.

Selecting the Correct Paper Type

The printer automatically adjusts itself for the type of paper you select in your print settings. That
is why the paper type setting is so important. It tells your printer what kind of paper you are using
and adjusts the ink coverage accordingly. The table below lists the settings you should choose for

your paper.
For this paper Select this paper type setting
Plain paper plain papers

Epson Bright White Ink Jet Plain Paper

Epson Professional Flyer Paper Epson Professional Flyer
Epson Photo Paper Epson Photo
Epson Matte Paper - Heavyweight Epson Matte

Epson Double-Sided Matte Paper

Epson Photo Quality Ink Jet Paper Epson Photo Quality Ink Jet
Envelopes Envelope
Note:

The availability of special media varies by location. For the latest information on media available in your area,
contact Epson customer support.
= See “Technical Support Web Site” on page 144.
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Chapter 3
Basic Printing

Introduction

This section guides you through the procedures for different kinds of printing.

Printing Photos

Explains how to print photos on various types of paper.
= See “Printing Photos” on page 32.

Printing Web Pages

Explains how to print Web pages so that they fit on a sheet of paper without getting cut off on the
right side.
= See “Printing Web Pages” on page 34.

B oee me
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Printing Documents

Explains how to print documents on various types of paper.
= See “Printing Documents” on page 36.

Printing on Envelopes

Explains how to print on envelopes.
= See “Printing on Envelopes” on page 38.

Printing Photos

Preparing the print file

You need to adjust the image file to the size of the paper. If your application has margin settings,
make sure that the margins are within the printable area of the page.
= See “Printable area” on page 159.
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Loading paper
Refer to the section below for details on loading paper.
= See “Loading Paper” on page 22.
When using special Epson paper, refer to the section below.

= See “Using Special Paper” on page 20.

Printer settings for Windows
Follow these steps to adjust your printer settings.
1. Access the printer settings.

= See “Accessing the printer driver for Windows” on page 14.

& EPSON XXXXxX Printing Preferences

G4 Main I@ Aivanced | ¢ Page Layout | &6 Maintenance |

Zuality Oplion

[

() Draft

[
.
'Hl:_"'l“_.

&)

i v S

O
T
ﬁ

(O Text & Image () weh () Photo

Paper Options Print Oplions

— [CIPrink Preview
Type: |Epscll'| Phato (:d) Quiet Mode
Size: | A4 210 x 27 mm () -~ [CIouplex Printing
N
Auko
Manual
Ink Levels Orienkation

u| - @ Portrait
| W ) (O Landscape

Reset Defaults Technical Suppart Show Settings

0K ][ Cancel ] Apply
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6.

7.

Click the Main tab, then select Photo in the Quality Option settings:
Select the paper source as the Source setting.

Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on page 30.

Select the appropriate Size setting. You can also define a custom paper size. For details, see the
online help.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before printing an
entire job.

Printing Web Pages

Loading paper

Refer to the section below for details on loading paper.

= See “Loading Paper” on page 22.

When using special Epson paper, refer to the section below.

= See “Using Special Paper” on page 20.

Using EPSON Web-To-Page

The EPSON Web-To-Page software lets you print Web pages so that they fit within the width of
your selected paper.

Note:
This software is not available for Windows Vista and XP x64.

Note for Windows Internet Explorer 7 users:
Printing web pages to fit to your paper size is a standard feature in Windows Internet Explorer 7.
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1. In Internet Explorer, go to the Web page you want to print.

If you have installed EPSON Web-To-Page, the EPSON Web-To-Page toolbar appears on the

Internet Explorer window.
2. Click the Print button on the toolbar. The Print window appears.

Note:

If you want to preview the layout of your printout, click the Preview button on the toolbar.

3. Right-click the printer icon and choose Printing Preferences in Windows XP and 2000.

& EPSON XXXXX Printing Preferences

€ Main I(ﬁ Advanced | €2 Page Layout | &6 Maintenance |

Quality Option

F

|

|
E»
%]
=h =] WWW|
[ -

(i
L)

() Draft () Text () Text & Image (%) web () Fhoto
Paper Cptions Print Options
Saurce: |Fronk Tray ) Settings... [Jreyerse Order

— — [T Prink Preview
Type: ||:|Iain papers (vl) [ quist Mads
Size: |.ﬁ.4 210 % 297 mm (V D [ ] Duplest Printing
s
Auko
IManual
Ink Levels Orientation

il | &
| | ‘_ (O Landscape

Reset Defaulks Technical Support Show Settings
L_0c_J|[ Gamcel | oo

4. Click the Main tab, then select Web as the Quality Option settings:
5. Select the paper source as the Source setting.
6. Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on page 30.
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7. Select the appropriate Size setting. You can also define a custom paper size. For details, see the
online help.

8. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
9. Click OK to close the printer settings window.

10. Print your page.

Printing Documents

Loading paper
Refer to the section below for details on loading paper.
= See “Loading Paper” on page 22.
When using special Epson paper, refer to the section below.

= See “Using Special Paper” on page 20.

Printer settings for Windows

1. Open the file you want to print.

2. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 14.

& EPSON X3(XXX Printing Preferences

l &4 Main Itﬁ Advanced | £35 Page Lavout | &6 Maintenance |

Quality Ophion
i fi— !
r =| BH: ‘m|
() Draft () Text () Text feImage ()web () Phoka
Paper Options Print Oplions

[reverse order

Source! | Fronk Tray ) Settings. .. |:|P =
rink Preview

Type: |p|ain papers ( Vl) [] Quiet Mode
Sige: |.0.4 210 % 297 mm (V ’ [Jouplex Printing
—
Auko
Manual
Ink Levels Crienkation

P
@Eortrait
() Landscape
R Reset Defaults Technical Support Show Settings
Co ) cores J[ oo

1l
.
1

Click the Main tab, then select one of the following Quality Option settings:

(d Draft for rough drafts with reduced print quality
d  Text for text-only documents with higher text quality
1 Text & Image for higher quality documents with text and images

Select the paper source as the Source setting.
Select the appropriate Type setting.
= See “Selecting the Correct Paper Type” on page 30.

Select the appropriate Size setting. You can also define a custom paper size. For details, see the
online help.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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8. Click OK to close the printer settings window.

9. Print your file.

Printing on Envelopes

Loading envelopes

Refer to the section below for loading envelopes.
= See “Loading Envelopes” on page 26.
Refer to the section below for the printable area.

= See “Printable area” on page 159.

Printer settings for Windows

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 14.

& EPSON X300XX Printing Preferences

€ Main I(ﬁ Advanced | €2 Page Layout | &6 Maintenance |

Quality Option
— y
= =™ | @
| = |
= E=z oo
() Draft (%) Text () Text & Image  ()web () Fhoto
Paper Cptions Print Options
— — [T Prink Preview
Type: |Envelu:||:|e ( vl) Quiet Mode

o
Size: |Envelope #104 1/8x91/zin (%)) -~ [Jouplex Printing
— 3

Auko

Tanual

Ink Lewels

TRl

Reset Defaulks Technical Support

O Partrait

Crrienkation

(%) Landscape

&

Show Settings

L ]S J[ Cancel ]

Apply

Click the Main tab, then select one of the following Quality Option settings:

d  Text for most envelopes
d Text & Image to print images on the envelope

Select Rear Tray as the Source setting.

Select Envelope as the Type setting.

Select the appropriate envelope size from the available Size settings. You can also define a

custom size. For details, see the online help.
Select Landscape as the Orientation setting.
Click OK to close the printer settings window.

Print your envelope.
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Canceling Printing

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the printer button

For B-500DN users
Press the T Cancel button to cancel a print job in progress.

For B-300 users

Press the a@ Paper/Cancel button to cancel a print job in progress.

For Windows

When you start printing, the progress meter appears on your computer screen.

Click the Stop button to cancel printing.

M EPSON XXXXX - USBOO1

EPSON Microsoft Word - EPSON.doc Remaining 0 sec

Page:0f1

Media Type : plain papers
Paper Size : &4 210 x 297 mm

[ Check Ink Levels ] [ Technical Support l
| Tips | [ Pause ] [ Skop ]

For great results, make sure you use genuine Epson ink #
cartridges,
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Chapter 4
Printing with Special Layout Opftions

Introduction

You can print with a variety of layouts for special projects, such as booklets and posters.

Double-Sided Printing (for Windows only)

Lets you print on both sides of the paper.
= See “Double-Sided Printing” on page 43.

Fit to Page Printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in
the printer driver.
= See “Fit to Page Printing” on page 56.

e
N
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Pages Per Sheet Printing
Lets you print two or four pages on a single sheet of paper.
L

= See “Pages Per Sheet Printing” on page 59.

Poster Printing (for Windows only)

Lets you enlarge material on a single document page to cover 4, 9, or 16 printed sheets of paper,

and then make a poster.
= See “Poster Printing” on page 62.

42
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Watermark Printing (for Windows only)

Lets you print text or an image as a watermark on each page of your printout.
= See “Watermark Printing” on page 68.

For example, you can put “Confidential” on an important document.

Double-Sided Printing

Two types of double-sided printing are available: standard and folded booklet.

Standard double-sided printing allows you to print the odd-numbered pages first. Once these
pages are printed, you can reload them to print the even-numbered pages onto the opposite side of
the paper.

) | -
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Folded booklet double-sided printing allows you to make single-fold booklets. The pages that will
appear on the outside (after the page is folded) are printed first. The pages that will appear inside
the booklet can then be printed after you reload the paper into the printer as shown in the
illustration below.

AN

P

Single-fold booklet
*%: Binding edge

You can create a booklet by printing pages 1 and 4 on the first sheet of paper, pages 5 and 8 on the
second sheet, and pages 9 and 12 on the third sheet.

After you reload these sheets into the rear sheet feeder, you can then print pages 2 and 3 on the
back of the first sheet of paper, pages 6 and 7 on the back of the second sheet, and pages 10 and 11
on the back of the third sheet.

The resulting pages can then be folded and bound together into a booklet.

Note:
Depending on the paper, stacks of up to 30 sheets can be loaded into the rear sheet feeder during
double-sided printing.

Only use papers that are suitable for double-sided printing. Otherwise, the printout quality may
deteriorate.

d  Depending on the paper and the amount of ink used to print text and images, ink may bleed through to
the other side of the paper.

A The surface of the paper may be smeared during double-sided printing.
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Standard double-sided printing

Automatic double-sided printing (using the duplex unif)

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet
using the duplex unit.

Note:
Automatic double-sided printing supports plain paper only.

1. Access the printer settings.

= See “Accessing the printer driver for Windows” on page 14.

& EPSON X3(XX Printing Preferences

4 Main Itﬁ Aidvanced | ¢35 Page Lapout | &8 Maintenance |

Quality Ophion
— y S—
= W=z e
() Draft () Text () Text feImage ()web () Phota
Paper Options Print Oplions

[reverse order
[]Print Preview

Saurce! |Front Tray ’ Sethings. ..

S
Type: |plain papers A i
| ( I) []quiet Mode
Size: |.ﬂ.4 210 % 297 mm (V ) [Touplex Prinking

p—
Auko
Manual

Ink Levels Orientation

__Il
__Hl

: (&) Portrait
|| L N (O Landscape

Reset Defaults Technical Support Show Settings
L0k [ Cancel || spny
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Click the Main tab, then select one of the following Quality Option settings:

Draft for rough drafts with reduced print quality
Text for text-only pages
Text & Image for higher quality pages with text and images

Web for web pages

U J o o

Photo for good quality and speed

Select the paper source as the Source setting.

Select plain papers as the Type setting.

= See “Selecting the Correct Paper Type” on page 30.
Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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7. Click the Page Layout tab, then select the Duplex Printing check box.

& EPSON XXXXxX Printing Preferences

| &8 Main | g2 .&dvancecl i Page Lapout |(ff§ Mainterance |

Maore Opkions
Rokake 150°

[ IMulti-Page
Pages Per Sheet

Poster Prinking

[ &

Print Page Borders

[Jreduce{Enlarge Document
By Cwtpuk Paper Size

B Percentage I:I o

[ IMirrar Image

Copies

Copies EI

Reverse Crder

Collate

o

() Manual{Ty

’[ Adiust Print Density. . ]l

Folded Booldet

Page Qrder...
W atermark
|None ha
AddiDel. .. Sethings...
C o (o 1[ oo

8. Select Auto to use automatic double-sided printing function.

9. Click Adjust Print Density to open the Print Density Adjustment window.

Print Density Adjustment

Select Document Type
() Texk with Phota () Photo Manual
Adjustments
Prink Density ) 2 (%)
-50 1]
Increased Ink Drying Time (X IE‘ (sec)
o &0
oK [ Cancel l [ Help l
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10.

11.

12.

13.

14.

15.

16.

17.

Select the appropriate document type as the Select Document Type setting.
Specify the Print Density and Increased Ink Drying Time as the Adjustments setting.

Note:
When you print data with dense photo on both sides of paper, reduce the print density and increase the
drying time to print finely.

Click OK to return to the Page Layout window.

Click Margins to open the Margins window.

Binding Edge

....... OTop  CORight

Binding Margin [tz B nz..118]

Uit

()0.01 cm (3)0.01 inch

I QK ] [gancel ] [ Help ]

Specify the edge of the paper where the binding will be placed. You can choose Left, Top, or
Right.

Choose cm or inch as the Unit setting. Then specify the width of the binding margin. You can
enter any width from 0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches.

Note:

The actual binding margin may be different from the specified settings depending on your application.
Experiment with a few sheets to examine actual results before printing the entire job.

Click OK to return to the Page Layout window. Then click OK to save your settings.

Load paper into the printer, then send the print job from your application.

= See “Loading Paper” on page 22.

Note:
Do not pull out the paper with force when the printer ejects paper after printing on one side.
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Manual double-sided printing

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet.

1. Access the printer settings.

= See “Accessing the printer driver for Windows” on page 14.

& EPSON XXXXX Printing Preferences

& Main ||($ Advanced | ¢ Page Layout | &6 Maintenance|

Quality Cption
— .‘J
—— &
= ih : | Lwww
() Draft (&) Text () Text & Image  ()'Web () Photo
Paper Options Prink Options

D Print Presview

—

Type: ||:|Iain papers

&

— [ 2uiet Mode
Size: | Ad 210 x 297 mm (@) —oupkexFrinting
Auko
Tanual
Ink Lewels Drientation
—A 3
@' Poartrait
|| ‘_ () Landscape
Reset Defaulks Technical Support Show Settings
| R

2. Click the Main tab, then select one of the following Quality Option settings:

a

Text for text-only pages

U J o

Web for web pages
A Photo for good quality and speed

3. Select Rear Tray as the Source setting.

Draft for rough drafts with reduced print quality

Text & Image for higher quality pages with text and images
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4. Select the appropriate Type setting.
= See “Selecting the Correct Paper Type” on page 30.
5. Select the appropriate Size setting.
6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, then select the Duplex Printing check box.

& EPSON XXxxX Printing Preferences
| ¢ Main | Advancecﬂ 3 Page Lapout rk@ Maintenarce
e ————————

More Options
Fotate 180° [ Mirror Image

[[reduce/Enlarge Document Copies

Erv Cutpuk Paper Size Copies

Reverse Order

<
By Percentage I:I %y Collate .

[CIrMulki-Page [#]D
Pages Per Sheet O Auto (&) Marual(T)
Poster Printing
I:I Adjust Prink Density, ..
Print Page Borders Eolded Boaklet

Page Qrder. ..

Wakermark.

| More -

add[Del... Settings. ..

L QK. ][ Cancel ] Apply

8. Select Manual to use manual double-sided printing function.
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9.

10.

11.

12.

13.

14.

Click Margins to open the Margins window.

() Right

Binding Edge

,,,,,,, O1Top

Binding Margin Bl |
Unit

()0.01 cm (3)0.01 inch

I QK ] [gancel ] [ Help ]

Specify the edge of the paper where the binding will be placed. You can choose Left, Top, or
Right.

Choose cm or inch as the Unit setting. Then specify the width of the binding margin. You can
enter any width from 0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches.

Note:
The actual binding margin may be different from the specified settings depending on your application.
Experiment with a few sheets to examine actual results before printing the entire job.

Click OK to return to the Page Layout window. Then click OK to save your settings.

Load paper into the rear sheet feeder, then send the print job from your application.
Instructions for generating the even-numbered pages will be displayed while the
odd-numbered pages are printed.

= See “Loading Paper” on page 22.
Follow the on-screen instructions to reload the paper.

Note:
The paper may curl during printing due to the amount of ink used. Should this occur, slightly curl
the sheets in the opposite direction before reloading them.

d  Align the sheet stack by tapping its edges against a hard, flat surface before reloading the stack.

Follow the instructions provided when reloading the printouts. Otherwise, paper may jam or the
binding margins may be incorrect.

If a paper jam occurs, refer to the following.
= See “The Paper Jams” on page 128.
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15. Once the paper is reloaded, click Resume to print the even-numbered pages.

Folded booklet double-sided printing

Manual double-sided printing

Use the following steps to create a folded booklet.

Note:
Folded booklet double-sided printing function is available only when manual double-sided printing is set.

1. Access the printer settings.

= See “Accessing the printer driver for Windows” on page 14.

& EPSON XXXXX Printing Preferences

& Main ||($ Advanced | ¢ Page Layout | &6 Maintenance|

Quality Cption
= i =
= ]
= ih : [lwrww]
() Draft (&) Text () Text & Image  ()'Web () Photo
Paper Options Prink Options
| — (AI) [ Print Presview
Type: | plain papers w :
[ 2uiet Mode
Size: | Ad 210 x 297 mm (@) —oupkexFrinting
Auko
Tanual
Ink Lewels Drientation

N

= @' Portrait
= L N () Landscape

E Reset Defaulks Technical Support Show Settings
) R
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Click the Main tab, then select one of the following Quality Option settings:

Draft for rough drafts with reduced print quality
Text for text-only pages
Text & Image for higher quality pages with text and images

Web for web pages

U J o o

Photo for good quality and speed

Select Rear Tray as the Source setting.

Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on page 30.
Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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7. Click the Page Layout tab and select the Duplex Printing check box. Then select Manual and
select the Folded Booklet check box.

& EPSON XXXxX Printing Preferences

| &8 Main | g2 .&dvancecﬂ i Page Lapout rh‘_ﬁ M airtenarce
—

Maore Opkions
Rotake 180° [ Mirror Image

[Jreduce{Enlarge Document Copies

By Cwtpuk Paper Size Copies EI

Reverse Crder

By Percentage I:I Uy Collate ﬂl ﬂl

[ IMulti-Page Duplex Frinting
Pages Per Sheet O Auto (& Manual(T)

Poster Prinking

l:l Adjust Print Density, .,

Print Page Borders [ Margins. .. F
Page Qrder...
W atermark
|None ha

AddiDel. .. Sethings...

L 0K ] [ Cancel Apply

8. Click Margins to open the Margins window.

Binding Edge  ()ieft! Top () Right:

Binding Margin [12 ... 118]

Uniik
()0.01 cm (3)0.01 inch

L QK J I_gancel ] l_ Help ]
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9.

10.

11.

12.

13.

Specify the edge of the paper where the binding will be placed. You can choose Left, Top, or
Right.

Note:
When you select Portrait as the Orientation setting, the Left or Right binding positions are available.
The Top binding position is available when you select Landscape as the Orientation setting.

Choose cm or inch as the Unit setting. Specify the width of the binding margin.

x
> g /\\\ A
I (i --3 = :\_ _____ ]
> % % A
Portrait Landscape

*: Folding edge
**: Margin

You can enter any width from 0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches. The specified
margin width will be used on both sides of the fold. For example, if you specify a 1 cm margin,
you will get a 2 cm margin (a margin of 1 cm will be placed on each side of the fold).

Click OK to return to the Page Layout window. Then click OK to save your settings.

Load paper into the rear sheet feeder, then send the print job from your application.
Instructions for printing the inside pages will be displayed while the outside pages are printed.

= See “Loading Paper” on page 22.
Follow the on-screen instructions to reload the paper.
Note:

[ The paper may curl during printing due to the amount of ink used. Should this occur, slightly curl
the sheets in the opposite direction before reloading them.

1 Align the sheet stack by tapping its edges against a hard, flat surface before reloading it in the printer.
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[ Follow the instructions provided when reloading the printouts. Otherwise, paper may jam or the
binding margins may be incorrect.

[ If a paper jam occurs, refer to the following.
w See “The Paper Jams” on page 128.

14. Once the paper is reloaded, click Resume to print the inside pages.

15. Once printing is complete, fold the sheets and bind them together using a stapler or other
binding method.

Fit to Page Printing

You can use the Fit to Page printing function when you want to print, for example, an A4 size
document on another size paper.

Fit to Page printing automatically resizes your page to the paper size you select. You can also resize
your page manually.

Printer settings for Windows

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 14.

& EPSON XXXXX Printing Preferences

[ @ Main I(ﬁ Advanced ” % Page Layout || Qfﬁ Maintenance|
Quality Option
= i i
() Draft (%) Text () Text & Image  ()web () Fhoto
Paper Cptions Print Options
SOUrCe! | Front Tray ) Setkings... [Jreyerse Order
| = (AD [CPrint Presviews
Type: |plain papers w :
[Juiet Mode
Size: | Ad 210 x 297 mm (v ] Duplex Printing
g
Auko
Tanual
Ink Lewels Drientation
—A —
| @ Partrait
| ] ‘_ (O Landscape
Reset Defaulks Technical Support Show Settings
o ) oo ] oo

2. Click the Main tab, then select one of the following Quality Option settings:

a

a
a
a
a

Draft for rough drafts with reduced print quality

Text for text-only pages

Text & Image for higher quality pages with text and images

Web for web pages
Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on page 30.
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5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, then select the Reduce/Enlarge Document check box.

& EPSON 300X Printing Preferences

| &4 Main | & .-’-‘«dvancec” i Page Lapout |@ Maintenance |
Maore Oplions
D Rotate 150° D Mirrar Image
l. FeducelEniaroe Document: l Copies
@ By Qutput Paper Size Copies EI
A4 210 237 mm v e
() By Percentage [ callate
[Imulki-Page [ buplex Printing
Pages Per Sheet AUt Marual T
Poster Printing
I:I Adiust Print Densiky. .,
Print Page Borders Margins. .. Folded Booklet
Page Order...
W' atermark,
|N0ne A
AddiDel, . Settings. ..
) cee [ oot

8. Do one of the following:
1 If you selected By Output Paper Size, select the size of the paper you are using from the
drop-down list.
[ If you selected By Percentage, use the arrows to choose a percentage.
9. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before printing an

entire job.
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Pages Per Sheet Printing

Pages Per Sheet printing allows you to print two or four pages on single sheets of paper.

| EEEa
X 'I'.|1..|..

[ 4

Printer settings for Windows

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 14.

& EPSON XXXXX Printing Preferences

[ @ Main I(ﬁ Advanced ” % Page Layout || Qfﬁ Maintenance|
Quality Option
= i i
() Draft (%) Text () Text & Image  ()web () Fhoto
Paper Cptions Print Options
SOUrCe! | Front Tray ) Setkings... [Jreyerse Order
| = (AD [CPrint Presviews
Type: |plain papers w :
[Juiet Mode
Size: | Ad 210 x 297 mm (v ] Duplex Printing
g
Auko
Tanual
Ink Lewels Drientation
—A —
| @ Partrait
| ] ‘_ (O Landscape
Reset Defaulks Technical Support Show Settings
o ) oo ] oo

2. Click the Main tab, then select one of the following Quality Option settings:

a

a
a
a
a

Draft for rough drafts with reduced print quality

Text for text-only pages

Text & Image for higher quality pages with text and images

Web for web pages
Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on page 30.
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5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, select Multi-Page, then select Pages Per Sheet.

& EPSON X3(XX Printing Preferences

|(§ E || Cﬁ .-’-‘«dvancec” i Page Lapout ||(f3 Maintenance|

Maore Oplions

D Rotate 150° D Mirrar Image

[JReducefEnlarge Document

Copies
By Qutpuk Paper Size Copies EI
[[Ireverse Order
B Percentage l:l [ callate

tulki-Page [ buplex Printing

(&) Pages Per Shest Auko Manual{T)

{:} Poster Prinking
Adjust Prink Density. ..

z
[CIPrint Page Borders Margins. .. Folded Booklet
Page Order...
W' atermark,
|N0ne A
AddiDel, . Settings. ..
) cee [ oot

8. Select from the following settings for Pages Per Sheet printing:

2,4 Prints two or four pages of your document on a single piece of paper.

Print Page Prints frames around the pages printed on each sheet.

Borders

Page Order Allows you to specify the order in which the pages will be printed on the sheet
of paper. Some settings may be unavailable, depending on the Orientation
setting on the Main window.

9. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before printing an

entire job.
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Poster Printing

Poster printing allows you to print poster-size images by enlarging one page to cover several sheets
of paper.

%4

Printer seftings

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 14.

& EPSON XXXXX Printing Preferences

[ @ Main I(ﬁ Advanced ” % Page Layout || Qfﬁ Maintenance|
Quality Option
= i i
() Draft (%) Text () Text & Image  ()web () Fhoto
Paper Cptions Print Options
SOUrCe! | Front Tray ) Setkings... [Jreyerse Order
| = (AD [CPrint Presviews
Type: |plain papers w :
[Juiet Mode
Size: | Ad 210 x 297 mm (v ] Duplex Printing
g
Auko
Tanual
Ink Lewels Drientation
—A —
| @ Partrait
| ] ‘_ (O Landscape
Reset Defaulks Technical Support Show Settings
o ) oo ] oo

2. Click the Main tab, then select one of the following Quality Option settings:

a

a
a
a
a

Draft for rough drafts with reduced print quality

Text for text-only documents

Text & Image for higher quality pages with text and images

Web for web pages
Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on page 30.
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Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click the Page Layout tab and select Multi-Page, then select Poster Printing. Click the up or

down arrow to select 2x1, 2x2, 3x3, or 4x4.

& EPSON XXXXX Printing Preferences

|(§ Main || (ﬁ .t’-‘n.dvancec” 3 Page Lapout |Qfﬁ Maintenance|

More Cptions

|:| Raotate 150° |:| Mirrar Image

[Jreduce/Enlarge Document Copies

B Qutpuk Paper Size Copies 1
[Jreverse Order

[ callate

By Percentage I:I S
[#] pMulti-Page

() Pages Per Sheet
=

Duplex Prinking

Aok

@ Poster Printing

E

L1} 1L0R

Manual(T)

Adjust Prink Density...

rs
w

il gy

Margins. .. Folded Booklet
Settings...
Watermark,
|Nnne b
add/Del... Settings. ..
L [ o ][ am
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8. Click Settings to adjust the way your poster will be printed. The Poster Settings window
opens.

Poster Settings

Flease select the panels

that wou don't wish to be

printed. (The panels which

appear graved oot will not

be printed)

[IPrint Cutting Guides
Cancel l [ Help
9. Make the following settings:
Print Cutting Prints guide lines for cutting.
Guides
Overlapping Slightly overlaps the panels and prints alignment markers so that the panels can
Alignment be aligned more precisely.
Marks
Trim Lines Prints border lines on the panels to guide you when trimming the pages.
Note:

If you want to print only a few of the panels without printing the entire poster, click the panels that you
do not want to print.

10. Click OK to close the Poster Settings window.
After completing the steps above, print one test copy and examine the results before printing an

entire job. Then follow the instructions.
=» See “How to make a poster from your printouts” on page 66.
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How to make a poster from your printouts

Here is an example of how to make a poster with 2x2 selected under Poster Printing and
Overlapping Alignment Marks selected as the Print Cutting Guides.

Sheet 1

Sheet 2

Sheet 3

Sheet 4

1. Cut off the margin of Sheet 1 along a vertical line through the center of the top and bottom cross

marks:

2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the

two sheets together from the back:

X
™| | 0 B
Sheet 1 | Sheet2 | mmsp | Sheet 1 Sheet 2
m| |[x o |

Sheet 1

Sheet 2
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3. Cut the taped sheets in two along a vertical line through the alignment markers (this time, a line

to the left of the cross marks):

X

i

i

Sheet 1i| Sheet2 -

g

Sheet 1

Sheet 2

4. Align the edges of the paper using the alignment markers and tape them together from the

back:

Sheet 1

X

K

Sheet 2

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 and 4 together.

6. Repeat the instructions from step 1 to step 4 to tape the top and bottom edges of the paper:

Sheet 1

Sheet 2

1T

Sheet 3

Sheet 4

7. Cut off the remaining margins.
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Watermark Printing

Watermark printing allows you to print a text-based or image-based watermark on your
document.

Printing the watermark

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 14.

& EPSON XXXXX Printing Preferences

[ € Main I(ﬁ Advanced | €2 Page Layout | &6 Maintenance |

Quality Option
— 4
— |
= | 5 |Lwrerw
() Draft (%) Text () Text & Image  ()web () Fhoto

Paper Cptions

Source:

Print Options
[Ireverse Order

Ink Lewels

5l Reset Defaulks

Technical Support

Frant Tray ) Settings. ..
| = (AD [CPrint Presviews
Type: |plain papers “ ;
[Juiet Mode
Size: | Ad 210 x 297 mm (» [ Duplex Printing
-
Auko
Tanual
Crrienkation
i
@ Partrait
‘_ () Landscape

Show Settings

QK. J[ Cancel ] Apply

Click the Main tab, then select one of the following Quality Option settings:

1 Draft for rough drafts with reduced print quality

1 Text for text-only documents with higher text quality

1 Text & Image for higher quality documents with text and images

Select the paper source as the Source setting.

Select the appropriate Type setting.
= See “Selecting the Correct Paper

Select the appropriate Size setting.

Type” on page 30.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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7. Click the Page Layout tab, choose the desired watermark from the Watermark list, then click

Settings.

& EPSON XXXXxX Printing Preferences

| &8 Main | g2 .-’-‘«dvancecl i Page Lapout I(ffﬁ Mainterance |

Maore Opkions

[Jrotate 180° [ |Mirror Image

[Jreduce{Enlarge Document Copies

By Cwtpuk Paper Size

B Percentage I:I o

[ IMulti-Page
Pages Per Sheet

Poster Prinking

[ &

Copies EI

[reverse order
[callate

[ ] Duplex Printing

Auko

Adjust Print Density, .,

Manual(T)

Prink Page Borders Margins. .. Folded Booklet
Page Qrder...
Watermark
|M
[ addjpel... ]m
L 0K ] [ Cancel ] Apply

If you want to create your own watermark, see the following instructions.

= See “Creating your own watermark” on page 71.
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8. Specify the settings you want for the watermark. You can change the position and size of the
watermark by dragging the image within the preview window.

W' atermark, IZZ|:|r|Fi|:Ier|ti-a|
Color |.Red v|
Position | [=] center v|
Light Dark,
Density 37
: - +
Size: ] J
[ o4 I ’ Zancel ] ’ Help ]

9. Click OK to return to the Page Layout window.
10. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before printing an
entire job.

Creating your own watermark

You can add your own text-based or image-based watermarks to the Watermark list.
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1. Click Add/Del under Watermark on the Page Layout window. The following window appears.

User Defined Watermarks

List (%) Text (IBMP

Marne : | |

Texk : | |

ok [ Cancel ] [ Help ]

2. Do one of the following:

d Touse an image file as a watermark, select BMP. Click Browse to locate the bitmap file you
want to use, then click Open. Type a name for your watermark in the Name text box, then
click Save.

[ To create a text-based watermark, select Text. Type your text in the Text box. This text will
also be used as the watermark name. If you want to change the watermark name, type a
new name in the Name text box, then click Save.

3. Click OK to return to the Page Layout window.
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4. Click Settings. The following window appears:

Watermark EF"E.I:Z:II"-I
Text | EPSON |
Color | B red V|
Fonk Setting
Font |.C\rial v|
Bold
Style Ttalic
Underline
Circle
Paositian | E| Center V| ~uare
Light Doark.
Densiky . |7
P Rotation
- +
Size _374- Angle Degres « —
| T R S O R TR I B §
C) Rokate with Mouse
[ ok ] [ Cancel l [ Help l

5. Make sure that the appropriate watermark is selected in the Watermark list, then select Color,
Position, Density, Size, Font, Style, and Angle settings. (For details, see the online help.) Your

settings are reflected in the preview window.

6. When you finish making settings, click OK.

Printing with Special Layout Options 73



B-300/B-500DN  User’s Guide

Chapter 5
Using the Control Panel

Introduction

You can use the printer’s control panel to access a variety of menus that allow you to check the
status of consumable products, print status sheets, and make printer settings. This section
describes how to use the control panel.

For B-500DN users

Explains how to use the control panel for B-500DN.

“Buttons and lights” on page 75

“Icons on the LCD” on page 77

“How to access the control panel menus” on page 78
“Control panel menu list” on page 78

“Status and error messages” on page 82

U J o dJ o o

“Printing the status sheet” on page 84

For B-300 users

Explains how to use the control panel for B-300.

[  “Buttons and lights” on page 85
d  “Status and error lights” on page 87

[  “Printing the status sheet” on page 90
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For B-500DN users

The control panel of the printer consists of 7 buttons, 3 lights, and a liquid crystal display (LCD).

iR ﬁ\\
6 [J

XX} Oy
)
[
- < |loc|] » |
v

Buttons and lights

The table below describes the functions of the buttons on the control panel.

Button Description

O

Power button

Turns the printer on or off.

Cancels the print job if pressed during printing.

m] Returns to the Ready status when pressed in Menu mode.

Cancel button
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<

Left button

Returns to the previous level when pressed in Menu mode.

A

Up button

Changes the parameter in the reverse order when selecting a desired parameter in
Menu mode.

\4

Down butfton

Changes the parameters in forward order when selecting a desired parameter in
Menu mode.

>

Enters Menu mode when pressed in the Ready statfus.

Selects a desired menu when pressed in Menu mode.

Right button
Sets the selected parameter in the selected item in Menu mode.
O I( Executes the item if the selected item is for execution only.
Feeds the paper when paper feed failed.
OK button

The table below describes the meanings of the lights on the control panel. The lights let you know
the status of the printer and the type of an error when it occurs.

Light

Description

O

Ink status light (orange)

On:

The installed ink cartridge is expended.

The ink cartridge is not installed.

The installed ink cartridges cannot be used with the printer.

The cartridge lock lever is in the unlocked position.

The installed maintenance box is at the end of its service life.
The maintenance box is not installed.

The installed maintenance box cannot be used with the printer.
The maintenance box cover is open.

Flashing:
The installed ink cartridge is nearly expended.
The maintenance box is nearing the end of its service life.

L)

Paper status light
(orange)

On:
No paper is loaded in the paper source.
The printer loads more than one sheet of paper at a time.

Flashing:
Paper is jammed.
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On:

Power light (green) The printer is in the Ready status.

Flashing:

The printer is starfing.

The printer is printing.

The printer is cleaning the print head.
The printer is charging the ink.

The printer is canceling printing.

Off:
The printer is off.

Icons on the LCD

This section describes the meaning of icons displayed on the LCD screen.

The table below describes the meaning of ink cartridge status icon.

Icon Description

The icon gives a rough estimate of the useable ink remaining in the ink

BREEE00

The installed ink cartridge is nearly expended.

The ink cartridge is not installed.
E The installed ink cartridges cannot be used with the printer.

The installed ink cartridge is expended.

The table below describes the meaning of maintenance box status icon.

Icon Description

The icon gives a rough estimate of the remaining capacity of the

l i H H u D D maintenance box.

The installed maintenance box is nearing the end of ifs service life.
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L5

The installed maintenance box is at the end of its service life.

E The installed maintenance box cannot be used with the printer.

The maintenance box is not installed.

How to access the control panel menus

This section describes how to enter Menu mode and make settings with the buttons on the control

panel.

Note:

Press the @ Cancel button whenever you want to exit Menu mode and return to the Ready status.

(A Press the 4 Left button to return to the previous step.

1. Make sure that “ appears on the LCD screen, and then press the » Right button. The first
menu appears on the LCD screen.

2. Press the ¥ Down or A Up button to scroll through the menus.

3. Press the OK or » Right button to select the desired menu. The first item appears on the LCD
screen.

4. Press the ¥ Down or A Up button to scroll through the items.

5. Press the OK or » Right button to select the desired item. The first parameter appears on the
LCD screen.

6. Press the ¥ Down or A Up button to scroll through the parameters.

7. Press the OKbutton to store the selected parameter. If the parameter is for execution only, press
the OK button to execute the function for the item.
After execution, the printer returns to the previous menu.

8. Press the T Cancel button. The printer returns to the Ready status.

Control panel menu list

This section describes the parameter for each item in the menu.

Using the Control Panel 78



B-300/B-500DN  User’s Guide

Printer setting menu

This menu allows you to configure the basic printer setting.

ltem Parameter
Language English, French, Italian, German, Spanish, Portuguese, Dutch, Japanese
Language

You can select the language displayed on the LCD screen.

Test print menu

This menu allows you to make settings related to test print.

Item Parameter

Nozzle check -

Status sheet -

Network sheet -

Nozzle check

You can print a print head nozzle check pattern for each ink cartridge. From the printing results,
you can check whether the nozzles are delivering ink properly.

= See “Checking the Print Head Nozzles” on page 107.
Status sheet

You can print the current printer status.

= See “Printing the status sheet” on page 84.

Network sheet

You can print the current settings of the network interface.
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Printer status menu

This menu allows you to check the current printer status.

Item

Parameter

Version

SH XXXX, XXXXX

Maintenance box

xx%

Version

You can check the firmware version.

Maintenance box

You can get a rough estimate of the remaining capacity of the maintenance box.

Maintenance menu

This menu allows you to make settings related to maintenance.

ltem Parameter
Head alignment -
Cleaning -

Cleaning sheet -

Contrast adj. -10-10

Head alignment

You can print a head alignment test pattern. From the printing results, you can adjust the head

alignment.

Cleaning

You can clean the print head. You can also print nozzle check pattern before cleaning.

Cleaning sheet

You can clean up the rollers inside the printer.

Contrast adj.

You can adjust the contrast of the LCD screen. Press the A Up or ¥ Down button to adjust contrast.
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Network setting menu

This menu allows you to make network settings.

ltem Parameter
Network setup Auto -
Panel IP address 000.000.000.000-255.255.255.255
Subnet mask 000.000.000.000-255.255.255.255
Default gateway 000.000.000.000-255.255.255.255
Bonjour On, Off
Init N/W set -

Network setup

You can select the method to configure the network settings.

When Auto is selected, the printer obtains the IP address, Subnet mask and Default gateway
automatically. When Panel is selected, you can specify the IP address, Subnet mask, Default
gateway and Bonjour settings using the control panel. When Init N/W set is selected, you can
revert the network settings of the printer to the factory default value.

IP address, Subnet mask, Default gateway

You can set the IP address, Subnet Mask, and Default Gateway to the printer. To change the
parameter, press the € Left or » Right button to move cursor and the A Up or ¥ Down button to
change number.

Bonjour

You can set the Bonjour settings of the printer.
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Status and error messages

This section describes the meaning of messages displayed on the LCD screen.

The table below describes the status messages.

Message Description
Cancel The print job is canceled.
Charging ink The printer is charging the ink.
Cleaning The printer is cleaning the print head.
Please wait The printer is starting.

The printer is initializing the settings.
Printing The printer is processing data.
Ready The printer is ready to print.
Power save The printer is in the power save mode.
Power off The printer is shutting down.

The table below contains error messages, a brief description of each message and suggestions for

correcting the problem.

Message

Problem

Solutions

Service call see guide

Service call error occurs.

Turn off the printer and then back on. If
the error does not clear, contact Epson
Service Center.

= See “Epson Service Center” on page
147.

Printer near end of service
life

Parts inside the printer are at the end of
their service life.

Contact Epson Service Center to
replace them.

= See “Epson Service Center” on page
147.

Nozzle maint error see
guide

Print head nozzles are clogged or
misaligned.

Perform the nozzle check and print
head cleaning.

= See "Checking the Print Head
Nozzles” on page 107.

= See “Cleaning the Print Head” on
page 109.

Press the OK button to recover from
error status.

Using the Control Panel

82



B-300/B-500DN  User’s Guide

Printer error restart printer

Printer error occurs.

Turn off the printer and then back on.

If the error does not clear, turn off the
printer and make sure no paper is
jammed in the printer, then turn back on
the printer.

= See “The Paper Jams” on page 128.

If the error does not clear again, turn off
the printer again and contact Epson
Service Center.

= See “Epson Service Center” on page
147.

Close maint box cover

The maintenance box cover is open.

Close the maintenance box cover.

Set maint box

The maintfenance box is not installed.

Install the maintenance box.

The maintenance box cannot be used
with the printer.

Install the genuine maintenance box.

Replace maint box

The maintenance box is at the end of its
service life.

Replace the maintenance box.

= See “Replacing a maintenance box”
on page 104.

Move ink lever down

The cartridge lever is in the unlocked
position.

Move the cartridge lever to the locked
position.

Set ink cartridge

The ink cartridge is not installed.

Install the ink cartridge.

Replace ink cartridge

The ink cartridge cannot be used with
the printer.

Install the genuine ink cartridge.

The ink cartridge is expended.

Replace the ink cartridge.

= See “Replacing an ink cartridge” on
page 98.

Set paper in cassette

Paper is not loaded in the front paper
cassette.

Load the paper in the front paper
cassette.

Set paper in auto feeder

Paper is not loaded in the rear sheet
feeder.

Load the paper in the rear sheet feeder.

Remove jammed paper

Paper is jammed in front paper cassette
or rear sheet feeder.

Remove the jammed paper.

= See “The Paper Jams” on page 128.

Double feed jam remove
paper

The printer feeds more than one sheet
of paper at a time.

Remove the jammed paper, and then
press the OK button.

Close printer cover

The printer cover is open during printing.

Close the printer cover.

Set duplex unit

The duplex unit is removed.

Attach the duplex unit.

Duplex unit jam remove
paper

Paper is jammed in duplex unif.

Remove the jammed paper.

= See “The Paper Jams” on page 128.
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Printing the status sheet

While in Menu mode, you can print a status sheet to see the current default values. To print a status
sheet, follow the steps below.

1. Make sure that A4 size paper is loaded in the front paper cassette.
2. Press the » Right button to enter Menu mode.

HT, and then press the OK or P Right

button.

4. Press the ¥ Down or A Up button to display &
button.

", and then press the OK or » Right

5. Press the OK button to start printing a status sheet.

After printing is finished, the printer returns to the Test print menu.

For B-300 users

The control panel of the printer consists of 3 buttons and 7 lights.
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Buttons and lights

The table below describes the functions of the buttons on the control panel.

Button Description

O

Power button

Turns the printer on or off.

Cleans the print head if pressed and held for 3 seconds.

O Prints a status sheet if the O Power button is pressed while holding down the ¢ Ink
button.
Ink button
Feeds and ejects the paper.
D ° ﬁ Restart printing when a double feed error is detected.

Feeds the paper when paper feed failed.

Paper/Cancel button Ejects the paper when the paper is jammed.

Cancels the print job if pressed during printing.

Prints the firmware version and the print head nozzle check pattern for each ink
cartridge if the O Power button is pressed while holding down the a@ Paper/Cancel
button.

The table below describes the functions of the lights on the control panel. The lights let you know
the status of the printer and the type of an error when it occurs.
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Light

Description

O

Ink status light (orange)

On:

The installed ink cartridge is expgnded.*

The ink cartridge is not installed. X
The installed ink cartridges cannot be used with the printer.

Flashing:
The installed ink cartridge is nearly expended.

G
Maintenance box status
light (orange)

On:

The installed maintenance box is at the end of its service life.
The maintenance box is not installed.

The installed maintenance box cannot be used with the printer.
The maintenance box cover is open.

The cartridge lever is in the unlocked position.

Flashing:
The maintenance box is nearing the end of its service life.

LJ

Paper status light
(orange)

On:
No paper is loaded in the paper source.
The printer loads more than one sheet of paper at a time.

Flashing:
Paper is jammed.
The duplex unit is not installed.

Power light (green)

On:
The printer is in the Ready status.

Flashing:

The printer is starting.

The printer is printing.

The printer is cleaning the print head.
The printer is charging the ink.

The printer is canceling printing.

Off:
The printer is off.

" Maintenance box status light is also on for these errors.

™ Maintenance box status light also flashes for this error.
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Status and error lights

This section describes the meaning of lights on the control panel.

The table below describes the lights showing the printer status.

ALY/
. ., 0 faching

Light Description
- The printer is ready to print.
sy

The printer is starting.

The printer is printing.

The printer is charging the ink.

The print job is canceled.

The printer is cleaning the print head.

The table below contains the lights showing the errors, a brief description and suggestions for
correcting the problem.

LYV

I B - on, I = flashing

Lights

Problem and solution

e [
¢ ==

Ink end

The installed ink cartridge is expended.

Replace the ink cartridge.

Ink cartridge error

The ink cartridge is not installed.

Install the ink cartridge.

The ink cartridge is not detected.

Install the ink cartridge again.

The installed ink cartridge cannot be used
with the printer.

Install the genuine ink cartridge.

Ink low

The ink cartridge is nearly expended.

Obtain the new ink cartridge.
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Maintenance box at the end of its service life

The maintenance box is at the end of its
service life.

Replace the maintfenance box.

Maintenance box error

The maintenance box is not installed.

Install the maintenance box.

The maintenance box is not detected.

Install the maintenance box again.

The maintenance box cannot be used with
the printer.

Install the genuine maintenance box.

The maintenance box cover is open.

Close the maintenance box cover.

Cartridge lever unlocked

The cartridge lever is in the unlocked
position.

Move the cartridge lever to the locked
position.

=

Maintenance box nearing the end of its service life

The maintenance box is nearing the end of
its service life.

Obtain the new maintenance box.

I

Paper out

Paper is not loaded.

Load the paper, and then press the
a@ Paper/Cancel button.

Double feed error

The printer feeds more than one sheet of
paper at a fime.

Remove the jommed paper, and then press
the a@ Paper/Cancel button.

Paper jaom

The paper is jammed.

Remove the jammed paper.

= See “The Paper Jams” on page 128.

Paper size error

The paper size set in the printer driver and
the size of loaded paper differ.

Match the paper size setting.

Duplex unit error

The duplex unit is not installed.

Install the duplex unit.
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(> ==
O mm

Printer cover open

(both lights continuously blink for 0.5 second twice and then go out for 1 second)

The printer cover is open during printing.

Close the printer cover.

Printer error restart printer
(both lights blink every 0.5 second)

Printer error occurs.

Turn off the printer and then back on.

If the error does not clear, turn off the printer
and make sure no paper is jommed in the
printer, then turn back on the printer.

= See “The Paper Jams” on page 128.

If the error does not clear again, turn off the
printer again and contact Epson Service
Center.

= See “Epson Service Center” on page 147.

Service required
(each light blinks alternatively)

Parts inside the printer are at the end of their
service life.

Contact Epson Service Center to replace
them.

= See “Epson Service Center” on page 147.

Nozzle maintenance required

Print head nozzles are clogged or
misaligned.

Perform the nozzle check and print head
cleaning.

= See “Checking the Print Head Nozzles”
on page 107.

= See “Cleaning the Print Head” on page
109.

Press the 0 Ink button to recover from error
status.

l ==

All lights

Unknown printer error

An unknown printer error has occurred.

Turn off the printer and then back on. If the
error does not clear, contact Epson Service
Center.

= See “Epson Service Center” on page 147.
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Printing the status sheet

You can print a status sheet to see the current default values. To print a status sheet, follow the
steps below.

1. Make sure that A4 size paper is loaded in the front paper cassette.
2. Turn off the printer.
3. Turn on the printer while holding down the 0 Ink button.

The printer prints the status sheet.
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Chapter 6
Installing Option

Duplex Unit (B-300 only)

Installing the duplex unit

Follow the steps below to install the duplex unit.
1. Turn off the printer

2. Press the hooks on both sides of the upper rear printer cover, and then remove the upper rear
printer cover.

Note:
The removed upper rear printer cover should be retained since it will be necessary when you remove the
duplex unit.
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3. Insert the bottom side of the duplex unit first, and then attach the duplex unit.

Uninstalling the duplex unit
Follow the steps below to uninstall the duplex unit.
1. Turn off the printer.

2. Remove the duplex unit by pulling it while holding down the buttons on both sides of the
duplex unit.
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3. Attach the upper rear printer cover.
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Chapter 7

Replacing Consumables

Ink Cartridges

Checking the ink cartridge status

Using the control panel (B-500DN)

To check the ink cartridge status, see “Icons on the LCD” on page 77.

Using the printer lights (B-300)

To check the ink cartridge status, see the # Ink status light for each color. The # Ink status lights let
you know the status of the ink cartridge.

Ink status light

Status

Off The ink cartridge remains enough for printing.
Flashing The ink cartridge is nearly expended.
On The ink cartridge is expended.

For Windows

Note:

Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink cartridges are
installed, the ink cartridge status will not be displayed.

To check the ink cartridge status, do one of the following:

1 Double-click the printer shortcut icon on your Windows taskbar. To add a shortcut icon to the
taskbar, refer to the following section.
= See “From the shortcut icon on the taskbar” on page 15.
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1 Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3
button.

& EPSON XXX Printing Preferences

|(§ Mazin | &4 Advanced | ©3% Page La_l,lnutil &6 Maintenance |I

"‘" : Stakus Maonitor 3 (M)
ﬂ Use this utility bo automatically check For errors and also check:

the lewel of ink remaining.

[ﬁ Mozzle Check (M)

A graphic displays the ink cartridge status.

B EPSON Status Monitor 3 : EPSON XXXXX

EPSON “**
Ready to print,

l_ Technical Suppart
Ink Levels

Te161 Tal6Z TE1E3 Tal64
l_ Inforrmation
IMainkenance Box Service Life
% 90%

Note:

If any of the ink cartridges installed in the printer is broken, incompatible with the printer model, or
improperly installed, EPSON Status Monitor 3 will not display an accurate calculation of the ink
cartridge status. Be sure to replace or reinstall any ink cartridge indicated by EPSON Status Monitor 3.
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(d  The progress meter appears automatically when you start a print job. Click the Check Ink
Levels button, and then you can check the ink cartridge status from this window.

Note:

To display the progress meter automatically, click the Maintenance tab in the printer driver window,

click Speed & Progress, and then select the Show Progress Meter check box.

B EPSON XXXXX - USBOO1

EPSON Microsaft Word - EPSOM, doc

Remaining 0 sec
Page:0/1

Media Tvpe : plain papers
Paper Size : A4 210 x 297 mm

’I_ Check Ink Lewvels ] l l_

Technical Suppart ]

1 | {

For great resulks, make sure wou use genuine Epson ink
cartridges,

| Tips Pause Stop l

o]

B EPSON XXXXX - USBOO1

EPSON Microsaft Word - EPSOM, doc

Remaining 0 sec
Page:0/1

Media Type : plain papers
Paper Size : &4 210 x 297 mm

Technical Suppart

L Hide Ink Lewvels J l_
Ink Levels
Tal6l Tal6Z TE1E3
Tips | [ Pause l [ Stop l

For great resulks, make sure wou use genuine Epson ink
cartridges.

Tele4

= o]
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Handling precautions

Read all of the instructions in this section before replacing the ink cartridges.

a

a

This printer uses ink cartridges equipped with an IC chip that monitors the amount of ink used
by each cartridge. Cartridges are usable even if they are removed and reinserted.

If you need to remove an ink cartridge temporarily, be sure to protect the ink supply area from
dirt and dust. Store the ink cartridge in the same environment as the printer. When storing the
cartridge, be sure that its label identifying the color of the ink cartridge is facing upward. Do
not store ink cartridges upside down.

The valve in the ink supply port is designed to contain any excess ink that may be released.
However, careful handling is recommended. Do not touch the supply port of the ink cartridge
or its surrounding area.

Ink is consumed during the following operations: print head cleaning, initial ink charging, and
nozzle maintaining.

Never turn off the printer during initial ink charging. The ink may fail to be filled up and the
printer may become unavailable to print.

If you change the ink cartridge to Extra High Capacity Ink Cartridge, retain the default ink
cartridge or Standard Capacity Ink Cartridge, or High Capacity Ink Cartridge. One of these
cartridges is needed when you transport the printer.

Other products not manufactured by Epson may cause damage that is not covered by Epson's
warranties, and under certain circumstances, may cause erratic printer behavior.

Keep ink cartridges out of the reach of children. Do not allow children to drink the ink or
handle the cartridges.

Be careful when you handle used ink cartridges, as there may be some ink around the ink
supply port or surrounding area. If ink gets on your skin, wash the area thoroughly with soap
and water. If ink gets into your eyes, flush them immediately with water. If discomfort or
vision problems continue after a thorough flushing, see a doctor immediately.

Epson recommends the use of genuine Epson ink cartridges. The use of non-genuine ink may
cause damage that is not covered by Epson's warranties, and under certain circumstances, may
cause erratic printer behavior. Epson cannot guarantee the quality or reliability of non-genuine
ink. The ink cartridge status is not displayed when non-genuine ink is used.

Leave the old cartridge installed in the printer until you have obtained a replacement;
otherwise, ink remaining in the print head nozzles may dry out.

You cannot continue printing with one ink cartridge expended, even if the other cartridges still
contain ink. Before printing, replace the expended cartridge.
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1 Never turn off the printer while replacing the ink cartridge. Doing so may damage the IC chip
on the ink cartridge and the printer may not print properly.

1 To ensure you receive premium print quality and to help protect your print head, a variable ink
safety reserve remains in the cartridge when your printer indicates to replace the cartridge. The
yields quoted for you do not include this reserve.

Replacing an ink cartridge

To replace the ink cartridge, follow the steps below.

1. Open the cartridge cover.
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3. Remove the expended installed ink cartridge.

Note:
Hold the printer with your hand when you remove the ink cartridge.

4. Remove the new ink cartridge from the package.
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Caution:
Do not touch the green IC chip on the side of the cartridge. This can damage the ink cartridge.

0 Always install an ink cartridge immediately after removing the old cartridge. If the cartridge
is not installed promptly, the print head may dry out and be unable to print.

5. For best results, shake the ink cartridge for about five seconds.

0:00'05"

6. Hold the ink cartridge with the arrow mark facing up and pointing to the rear of the printer,
and then insert it into the slot.
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Note:
Hold the printer with your hand when you install the ink cartridge.

Caution:
Do not remove and reinsert cartridges more often than necessary. Doing so can compromise the

needle valve seal and allow air to enter the ink tubes, causing nozzle loss.

7. Move the cartridge lever to the locked position.

8. Close the cartridge cover.

Note:
When you install the Extra High Capacity Ink Cartridge, use the printer with the cartridge cover opened.
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Maintenance Box

Checking the maintenance box status

Using the control panel (B-500DN)

To check the maintenance box status using the control panel, follow the steps below.

1. Make sure that

" appears on the LCD screen, and then press the » Right button. Menu

appears on the LCD screen.

button.

3. Press the ¥ Down or A Up button to select i

button

4. Arough estimate of the remaining capacity of the maintenance box appears on the LCD screen.

Note:

You can check the maintenance box status by the icon displayed on the lower right of the LCD screen as well.

= See “Icons on the LCD” on page 77.

Using the printer lights (B-300)

To check the maintenance box status, see the &, Maintenance box status light. The & Maintenance

box status lights let you know the remaining free capacity of the maintenance box.

i, and then press the OK or » Right

#, and then press the OK or » Right

Maintenance box status light

Status

Off The maintenance box has enough free capacity.
Flashing The maintenance box is nearing the end of its service life.
Oon The maintenance box is at the end of its service life.

For Windows

Note:

Epson cannot guarantee the quality or reliability of non-genuine maintenance box. If non-genuine
maintenance box are installed, the maintenance box status will not be displayed.

To check the maintenance box status, do one of the following;:
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taskbar, refer to the following section.
®» See “From the shortcut icon on the taskbar” on page 15.

button.

@ Double-click the printer shortcut icon on your Windows taskbar. To add a shortcut icon to the

1 Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3

& EPSON XXX Printing Preferences
|(§ Mazin | &4 Advanced | ©3% Page La_l,lnutll &6 Maintenance |I

Stakus Maonitor 3 (M)

A
.'i]

=

the lewel of ink remaining.

Mozzle Check (M)

Use this utility bo automatically check For errors and also check:

A graphic displays the maintenance box status.

D EPSON Status Monitor 3 : EPSON XXXXX

EPSON "

Ready to print,

l_ Technical Suppart

Ink Levels

Teles

Telel Telez

Tele4

Inforrmation

IMainkenance Box Service Life

% 90%
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Note:

If the maintenance box installed in the printer is broken, incompatible with the printer model, or
improperly installed, EPSON Status Monitor 3 will not display an accurate calculation of the
maintenance box status. Be sure to replace or reinstall any ink cartridge indicated by EPSON Status
Monitor 3.

Handling precautions

Read all of the instructions in this section before replacing the maintenance box.

a

U J o oJ oo

Epson recommends the use of genuine Epson maintenance box. The use of non-genuine
maintenance box may cause damage that is not covered by Epson's warranties, and under
certain circumstances, may cause erratic printer behavior. Epson cannot guarantee the quality
of reliability of non-genuine maintenance box. The maintenance box status is not displayed
when non-genuine maintenance box is used.

Do not dismantle the maintenance box.

Do not touch the green IC chip on the side of the maintenance box.

Keep out of reach of children, and do not drink the ink.

Do not peel off the film covering the maintenance box.

Do not tilt the used maintenance box until it is placed in the plastic bag provided.

Do not reuse a maintenance box which has been removed and left detached for a long period.

Replacing a maintenance box

To replace the maintenance box, follow the steps below.

1.

Confirm that the printer is not draining the ink.
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2. Open the maintenance box cover.

3. Remove the new maintenance box from the package.
4. Lift up and pull the installed maintenance box outward.

Note:
QDo not tilt the maintenance box when you uninstall the maintenance box.

[ Hold the maintenance box with both hands when you handle the maintenance box.

5. Put the used maintenance box into the plastic bag, and then seal off.

Note:
The plastic bag is provided with the new maintenance box.
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6. Insert the new maintenance box into place as far as it will go.

7. Close the maintenance box cover.
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Chapter 8

Maintaining Your Printer

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to
identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility or
from the printer by using the control panel or buttons.

Note:
This printer checks the print head on a regular basis to keep the print head clean and to ensure you receive
premium print quality. If the print head nozzles are clogged, the printer automatically cleans the print head.

Normally, you do not need to perform the nozzle check and print head cleaning, however, the self-cleaning
function cannot completely prevent the occurrence of missing dots.

Using the Nozzle Check utility for Windows
Follow the steps below to use the Nozzle Check utility.
1. Make sure that no lights are indicating errors.
2. Make sure that A4 size paper is loaded in the front paper cassette.
3. Right-click the printer icon on the taskbar, then select Nozzle Check.
If the printer icon does not appear, refer to the following section to add the icon.
= See “From the shortcut icon on the taskbar” on page 15.

4. Follow the on-screen instructions.

Using the control panel (B-500DN)

Follow the steps below to check the print head nozzles using the control panel.

1. Make sure that A4 size paper is loaded in the front paper cassette.
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2. Make sure that BE#LY appears on the LCD screen, and then press the » Right button. Menu
appears on the LCD screen.

3. Press the ¥ Down or A Up button to select Tt
button.

, and then press the OK or » Right

4. Press the ¥ Down or A Up button to select i
button.

., and then press the OK or » Right

5. Press the OK button to print nozzle check pattern.

After printing, the cleaning menu appears. If you find a print quality problem, press the OK
button to clean the print head.

Using the printer buttons (B-300)

Follow the steps below to check the print head nozzles using the printer buttons.
1. Make sure that no lights are indicating errors.

2. Turn off the printer.

3. Make sure that A4 size paper is loaded in the front paper cassette.

4. Hold down the a# Paper/Cancel button and press the O Power button to turn on the printer.

5. When the printer turns on, release both the buttons.

Below are two sample nozzle check patterns.
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Compare the quality of the printed check page with the sample shown below. If there are no
print quality problems, such as gaps or missing segments in the test lines, the print head is fine.

—

If any segment of the printed lines is missing, as shown below, this could mean a clogged ink
nozzle or a misaligned print head.

[T

IR
fHii
|

[T
[EEEET

= See “Cleaning the Print Head” on page 109.
= See “Aligning the Print Head” on page 112.

Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to solve
these problems by cleaning the print head, which ensures that the nozzles are deliveri